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READ ME FIRST

Welcome to Take Control of Getting Started with Dreamweaver,
version 1.0.

This book shows you how to use Dreamweaver 8 to create a basic
Web site for small businesses and nonprofits, consultants, schools,
and individuals. This book was written by Arnie Keller, edited by
Lea Galanter, and published by TidBITS Electronic Publishing.

To get in touch or learn more about the Take Control books, you can:

• Contact us by sending email to tc-comments@tidbits.com.

• See About This Ebook to learn about the author and publisher.

• Read the fine print on the copyright page.

• Find answers to general questions by reading the FAQ at
http://www.takecontrolbooks.com/faq.html.

• Buy another book by checking out our Featured Titles or by
visiting http://www.takecontrolbooks.com/catalog.html.

The price of this ebook is $10. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend Take Control! button on the cover makes it easy for you to
give your friend a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.

Onscreen Reading Tips
We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

• Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.
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• Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

• In Adobe Acrobat Pro version 6 or 7, set your preferences to view
Web URLs in a Web browser: choose Acrobat > Preferences, switch
to the Web Capture pane, and choose In Web Browser from the
Open Web Links pop-up menu.

• Find more tips in the Take Control FAQ on the Web.

Video Screenshots
This book uses video to animate the screenshots in some of its figures.
To play the video associated with a screenshot:

• When reading from a paper version of the book, point your Web
browser at http://www.takecontrolbooks.com/dreamweaver/ for
a list of all the videos and click their links to view them.

• When reading online, simply click the figure.

In either case, the video will play in your Web browser via Flash
Player 8.

NOTE GET SET UP FOR THE VIDEO SCREENSHOTS

To check whether you have Flash Player 8 installed, visit
http://www.takecontrolbooks.com/dreamweaver/detect/.

If you need Flash Player 8, a link on that page directs you to the Flash
player site where you can download it.

For the best playback experience, keep the videos in the front window
of your computer as it plays. Otherwise, the audio may stutter.

Printing Tips
Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

Want a high-quality, spiral-bound printout? Click the
Check for Updates button on the cover to learn about our print
service that prints this ebook as a handy paper book.
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• Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

• Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

• For a tighter layout that uses fewer pages, check your printer
options for a 2-up feature that prints two pages on one piece of
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then
choose 2 from the Pages per Sheet pop-up menu. You may also
wish to choose Single Hairline from the Border menu.

• When printing on a color inkjet printer, to avoid using a lot
of color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
In reading this book, you may get stuck if you don’t know certain
basic facts about Dreamweaver or if you don’t understand Take
Control syntax for things like working with menus or finding items
in the Finder. Please note the following:

• Path syntax: This book occasionally uses a path to show the loca-
tion of a file or a folder in your file system. Path text is formatted
in bold type. For example, Tiger stores most utilities, such as
Calculator, in the Utilities folder. The path for Calculator is:
/Applications/Utilities/Calculator.

The slash at the start of the path tells you to start from the root
level of the disk.

• Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that saves a file
from Dreamweaver is “File > Save.”
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• Finding Dreamweaver’s Preferences: From time to time, I
refer to preferences in Dreamweaver that you may want to adjust:

◊ Macintosh: To display Dreamweaver’s preferences (not to
be confused with the systemwide settings found in the System
Preferences application), choose Dreamweaver > Preferences
(Command-U).

◊ Windows: On Windows, choose Edit > Preferences (Ctrl-U).

Within that dialog, click an item at the left to display a pane with
that category of preferences. Instead of giving detailed directions
each time, I refer to each pane using an abbreviated notation such
as “go to the Accessibility preference pane.”

NOTE TRY BEFORE YOU BUY

You can download a fully functioning, 30-day trial version of
Dreamweaver 8 at http://www.adobe.com/cfusion/tdrc/index.cfm?
product=dreamweaver.
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INTRODUCTION

Dreamweaver is a WYSIWYG—what you see is what you get—
Web development tool. That means that as you add text, graphics,
and other objects, you immediately see what your page looks like
on the Web. Working with Dreamweaver is a lot like working with
a word processor: You enter content, arrange it, and format it. Both
a word processor and Dreamweaver work behind the scenes to make
what you write look as you intend. A word processor embeds invisible
tags, which have meaning only within documents that the word pro-
cessor creates. Dreamweaver also embeds invisible tags, but they’re
in HTML (hypertext markup language), the common language of the
Web. These tags tell browsers how to display your pages.

Dreamweaver dominates the field of WYSIWYG Web development
tools because it best combines power and ease of use. It can create
sites ranging from those for large organizations with complex needs
to those for individuals with simple needs. It can accommodate teams
of designers working together or a solo designer working alone. It’s
flexible enough for people who want to write HTML and for people
who don’t.

Mastering Dreamweaver isn’t trivial, but you can readily tap into
much of its power. I wrote this book as a short guide to help you learn
Dreamweaver’s essentials, not as a huge volume that covers its every
nuance and feature. I won’t show you how to create an industrial-
strength site; I will show you how to create a simple, attractive, helpful
site. Using a tutorial, I answer the question how do I do this? with
step-by-step instructions. But sometimes, I use the Web to provide
you with video screenshots and other resources to illustrate the points
I’m making. For a complete listof these resources, with links, go to
http://www.takecontrolbooks.com/dreamweaver/. In brief, I combine
what print and electronic media each do best. Let’s begin.

NOTE DREAMWEAVER VERSIONS

As I write, Dreamweaver 8 is the latest version available, but in
most cases, I use methods that also work with the previous version,
Dreamweaver MX2004. The interface may differ a bit—Adobe some-
times moves things around for reasons known only to Adobe—but
the features are largely unchanged.
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DREAMWEAVER QUICK START

The text in this book is crafted tutorial-style, and you should work
through the sections in sequence in order to build your skills as you
proceed from creating a modest Web page to a working Web site.
Here’s a quick look at what you’ll cover in each section:

Learn the basic Dreamweaver interface:

• Explore the Dreamweaver Interface by watching video screenshots
that give you a basic tour of Dreamweaver’s interface and help
you learn about the Property inspector, which you use to configure
elements on a Web page.

Create your first pages:

• Create a simple page with text, graphics, and working Web links.
See Your First Page: Text, Graphics, and Links.

• Your first page works okay, but the text isn’t particularly attractive
or helpful. Learn how to style it with Cascading Style Sheets (CSS)
in Your Second Page: Moving Beyond Bland.

• Your text is looking better, but your layout won’t win any awards.
Read Your Third Page: Lay Out Pretty Pages to learn how to use
CSS to position your page elements with layers.

Create your first Web site:

• Link your pages together in Your First Web Site, and give your site
a consistent, organized appearance.

• Provide consistent Navigation: Learn about Navigation Bars; get
the scoop on linking with Absolute links and Relative links; and
find out how to Make a Graphical Navigation Bar and how to
Design a CSS-Based Navigation Bar.

Put it out there:

• If nobody knows that a tree falls in the forest, does it matter? If
nobody can visit your Web site, does it matter? Learn how to Put
Your Site on the Web.

This is a free sample of “Take Control of Getting Started with Dreamweaver.”
Click here to buy the full 88-page ebook for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU44998372188&PT=TRK-0035-SAMPLE


Page 8

EXPLORE THE DREAMWEAVER INTERFACE

Dreamweaver is a powerful program that can do lots of things, so
it follows that its interface has lots of different elements. If you are
the sort of person who feels more comfortable in a program after
you’ve spent some time learning the interface, take some time now
to examine the video screenshots in this section, which guide you
through learning the Dreamweaver interface.

Click the image in Figure 1 to view a video about the menu bar,
Insert toolbar, main work area, and Property inspector.

FIGURE 1
Click this

figure to see a
video screen-

shot in your
Web browser.

If you need
help viewing

the video
screenshot,

see Video
Screenshots

(p. 3) for
more info.

Learn Interface Basics: Notice, from top to bottom, the menu bar,
the tabbed Insert toolbar (located inside the Insert window), the
main work area, and the Property inspector.

The Property inspector is where you can view and set attributes for
common objects like text and graphics. When you select an object, the
inspector displays settings only for that kind of object. For example, if
you highlight some text, the Property inspector changes to show only
the properties relevant to text, such as the font and size (Figure 1).

This is a free sample of “Take Control of Getting Started with Dreamweaver.”
Click here to buy the full 88-page ebook for only $10!

http://www.takecontrolbooks.com/dreamweaver/interface_vid/interface.html
http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU44998372188&PT=TRK-0035-SAMPLE


Page 9

You can play with Figure 2 in order to learn the ins and outs of four
views of the Property inspector—those for text, graphics, layers, and
tables—that are used most often in this book.

FIGURE 2
Click this

figure to see
an interactive
screenshot in

your Web
browser.

If you need
help, see

Video
Screenshots

(p. 3) for
more info.

Meet the Property Inspector: You spend a lot of your time working
with the Property inspector, so get the most out of it by learning
about four of its most important modes—text, graphics, layers,
and tables.

TIP IS YOUR AUDIO STUTTERING?
If the audio in your video screenshot is stuttering, prevent the
problem by making the playback window frontmost on your
computer screen.
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YOUR FIRST PAGE: TEXT, GRAPHICS, AND LINKS

We’ll begin our Dreamweaver tutorial by creating a simple Web page
containing basic items—text, graphics, and a couple of links to sites
already on the Web. Yet with just these elements, we’ll make a real
page that does—albeit in a limited way—most of what every other
page on the Web can do.

Create a Folder to Hold Your Work
It’s a good habit to keep your work on a Web site in a folder. So start
by creating a folder (on your Desktop or other convenient location) in
which to put all your files and other folders. Name it TakeControl and
you’re ready to begin.

Launch Dreamweaver
When you first launch Dreamweaver, if you haven’t changed the
default, you see the Start Page, which lets you open one of the
following:

• A recent page (only, of course, if you’ve earlier created any)

• One of the document types that Dreamweaver knows how to create
(in addition to HTML pages)

• A sample page on which to base your own

I suggest that you select the Don’t Show Again checkbox in the lower
left corner, so that you can create new pages without negotiating the
Start Page. However, until you select Don’t Show Again, you have to
choose one of the options listed, so in the Create New list, click HTML
to get started.

From now on, I’ll assume that you’ve disabled the Start Page. (If you 
want to re-enable it, use Dreamweaver’s General preference pane.)

Build Your First Page
If you’ve already opened a new HTML page via the Start page,
skip ahead to Step 6 in the following steps. Otherwise, to create
a new page:

1. Choose File > New.

Dreamweaver opens the New Document dialog (Figure 3).
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YOUR SECOND PAGE: MOVING BEYOND BLAND

Although the page you’ve created in the previous section won’t be
Site of the Week anytime soon, it does have a few key Web objects—
text, graphics, and links. At this point, we want to do something
about the bland text and boring layout.

When your browser displayed the page you created in the previous
section, it used whatever its default font happened to be. That’s
because you didn’t specify which font the browser should use or
whether the text should be “styled” in a certain color, size, or weight.

However, styling text means more than making it pretty. How text
looks signals your readers about how you’ve structured your content.
For example, readers should be able to tell at a glance what your main
heading is, as well as immediately recognize your various subheadings
and the main body of your page. And you definitely want them to
instantly recognize a link or a warning when they see one.

This doesn’t imply that attractiveness shouldn’t matter but rather
that how text looks carries meaning. The best tool to style text for
both appearance and function is Cascading Style Sheets (CSS), a
set of rules that all modern browsers support.

Understand Styles
A style is a description that tells the browser how to display text. To
pick up on the examples in the intro to this section, you might decide
that the style for your main head should be this:

MAIN HEAD
That is, its font would be Arial, its weight bold, its color red, and its
size large. (See the “Defining Font Sizes” note (next page) for what I
mean by “large.”)

You might also decide that your first subhead should have this style:

Subhead

Like your main head, its font would also be Arial, its weight bold,
and its color red. Its size, however, would be medium. And finally,
you might want your body text to look like this:

Body text

This is a free sample of “Take Control of Getting Started with Dreamweaver.”
Click here to buy the full 88-page ebook for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU44998372188&PT=TRK-0035-SAMPLE


Page 31

YOUR THIRD PAGE: LAY OUT PRETTY PAGES

Working tutorial-style in the previous sections of this book, you’ve
barely skimmed the surface of Dreamweaver’s power. Your pages are
beginning to get more attractive and useful, but you’re still stuck with
an uninspiring layout. That’s because browsers normally show text
and graphics in the order they appear in an HTML file. So if you have
some text, a carriage return, a graphic, another carriage return, and
some more text, that’s the order in which the browser shows them,
going from left to right and top to bottom. That makes for a pretty
boring page, and boring pages make for ex-visitors.

In fact, some research now claims that visitors make up their minds
whether to stay at your site within seconds. If they don’t find your site
appealing—and they alone get to define appealing—they’re gone. As
they say in the dandruff commercials, you get only one chance to
make a first impression.

But good layout isn’t about aesthetics alone. Just as styled text helps
readers see what’s more or less important, layout helps them see how
you’ve structured content. A good layout shows readers where to look
and where to click, as well as makes their visit to a site more pleasing.

Warning! Browsers for older operating systems do not support
CSS well—or in some cases, at all. If a major portion of your
audience consists of people running Mac OS 9, Windows 95,
or Windows 98, CSS prevents them from seeing your pages as
you intend.

Learn about Layers
In addition to telling browsers how to style text, CSS tells them how
to position objects on the page with single-pixel precision. To accom-
plish that, CSS includes the <div> tag, which creates a self-contained
rectangle that can contain any HTML object—text, graphics, media,
or even another <div>. Dreamweaver calls that rectangle a layer,
although more recent versions of the program also call it a <div>.
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YOUR FIRST WEB SITE

Just as a style sheet is a collection of styles, a Web site is a collection
of pages. And just as Dreamweaver has tools that make page design
easier, it also has tools that make site design easier.

For example, as soon as you start work, Dreamweaver creates and
maintains a mini-database that monitors your pages, along with their
links, graphics, and styles—in short, all your “assets.” That’s a power-
ful feature, because once you get beyond a few pages, it becomes all
too easy to lose track of where things are. And because Dreamweaver
continually updates this database, you can be confident that moving a
file or changing a link won’t have a disastrous consequence elsewhere.

However, before we look at these site tools in more detail, let’s step
back to think about sites in general. People will come to your site for
a  variety of reasons—information, entertainment, and commerce are
three common reasons. Their focus will be on what they want to do,
whether it’s finding the latest news, hearing a song, or buying a wid-
get. They will notice the machinery of the site only if it gets in their
way. (Do you remember which font your favorite magazine uses for
its headers or which of its pages use four-column layouts?)

The goal of a Web site, therefore, is to serve its readers, to help them
accomplish what they want to do as quickly and as easily as possible.
By all means, a site can be beautiful, entertaining, or educational, but
its first requirement is to be useful.

There are several ways to make a site and its content useful, but
perhaps the most important is consistency.

Design Pages Consistently
A site’s design should be consistent, that is, it must place the same
general elements in the same place on every page. The first page your
visitor sees establishes expectations about all the others: content will
be here, for example, links will be there, headers will look like this.
When a basic element suddenly changes, readers have to reorient
themselves and relearn how to read your page. Those changes don’t
have to be huge, like switching the location of the main content from
the left to the right. They can be as subtle as a different font size or
color, or even shifting your logo a few pixels. Because any change can
distract readers from doing what they want, Web surfers won’t hang
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NAVIGATION

When you build navigation into a site, you can build it into the
site’s template, so it works consistently across all pages in the site,
making it easy and enjoyable for visitors to find their way around on
your site. Dreamweaver supports many different navigation options,
including a simple list of text-based links, links that change color or
animate when a user hovers over or clicks them, links in menus and
submenus, links embedded in images, and animated links.

However, having many navigation options doesn’t mean you should
use all of them in one site—usually, you should pick one option that
matches your site well and stick with that. If your site has many pages
and branches, you may need a more complex navigational device, such
as menus with submenus. On the other hand, for small sites—say ten
or fewer pages—simpler is better. For example, just previously, in Edit
the Template to Add Links, you created a bulleted list that functioned
quite nicely as a navigational device.

Learn about Navigation Bars
You probably see navigation bars (also called navbars) all the time
as you surf the Web. A navigation bar usually appears at the top or
left side of a Web page and provides a useful grouping of links to
other pages or areas of a Web site (Figure 21).

FIGURE 21

To ensure that readers never have to hunt for links to the main sec-
tions of your site, you may wish to place identical navigation bars in
the same location on every page on your site.

Dreamweaver has several methods for creating a navbar; in this
section, I first teach you how to use graphics for buttons in a navbar,
and then I explain how to use CSS to make a navbar.

The graphical-buttons method is best if you want a visually rich look
and you have graphics that support the feeling you want your site to
convey. On the other hand, CSS-based navbars are particularly easy
to edit, are less error-prone, and load faster in browsers.
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PUT YOUR SITE ON THE WEB

If you’ve been following along in this tutorial, you should have a
small Web site, complete with an attached style sheet and a functional
navigation system. To this point, you’ve been developing your site
locally, creating and testing files on your hard drive. Your potential
visitors, of course, most likely don’t have access to your computer,
so they can’t see what you’ve produced. You’re ready to publish your
site by uploading it to a Web server so that the whole world can see
it. Before I discuss the mechanics of that, however, let’s look at the
big picture.

A site on the Web usually involves three computers—yours, your
visitor’s, and a Web server. As Figure 25 illustrates, there’s a strict
flow to the communication among these machines. Your computer
(where you create and store everything for your site) speaks only to
the Web server (the computer where your ISP has reserved space for
you). You send copies of your site’s files to that machine; you always
retain the originals on your local hard drive.

FIGURE 25 In a typical situation, before
a visitor can see your Web
page, three computers must
communicate:

• From your computer, you
send copies of files to the
server so they can be served.
(Sometimes you might ask for
a file back from the server—in
order to edit it, or you might
delete a file from the server)

• A visitor’s computer requests
files from the server.

• The server sends requested
files to the visitor’s browser.

At the other end of the process, your visitor’s computer speaks only
to the server, asking for and receiving copies—never the originals—of
the files it wants. Your site administrator manages the technical infra-
structure that makes these exchanges possible; unless you are the
administrator, it’s a black box that just works.
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LEARN MORE

There’s no shortage of books and Web sites about Dreamweaver and
Web design, and here are some of my favorites. They offer more com-
prehensive information than what’s possible here.

Books
• Dreamweaver 8: The Missing Manual

by David McFarland, published by Pogue Press
Like everything in the Missing Manual series, this book is
thorough, well written, and well presented.

• Dreamweaver 8 Bible
by Joseph W. Lowery, published by Wiley
For sheer coverage, you can’t beat the Bible series, and this volume
is no exception.

• Macromedia Dreamweaver 8 for Windows and Macintosh:
Visual QuickStart Guide
by Tom Negrino and Dori Smith, published by Peachpit Press
Both visually attractive and clearly written, this book keeps a sharp
focus on current Web standards and best practices.

• Don’t Make Me Think: A Common Sense Approach to Web
Usability
by Steve Krug, published by New Riders Press
The title is bang-on—common sense suggestions for testing that
your site’s design helps, not hinders, your visitors.

Web Sites
• Dreamweaver Support Center: This site has the latest

updates, technical notes, and links to the Dreamweaver Exchange.
It’s not the fastest site you’ve ever been to—its slowness has been
known to cause cerebral hemorrhages—but it’s an essential source.
http://www.adobe.com/support/dreamweaver/

• Project Seven: If these guys don’t produce the best Dream-
weaver extensions on the planet, they’re close. Not only are their
commercial products rock-solid and easy to use, their freebies are
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